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AudioTracker - Introduction

1.1 Introduction

AudioTracker is a hard disk recording system which has been developed

especially for the Atari Falcon 030 computer. It makes full use of the Falcon's

audio sub-system and digital signal processor (DSP). The program can run on a

Falcon with minimum of additional hardware (an internal hard disk is assumed to

be present) - professional work in CD/DAT quality, however, requires that the

Falcon's relatively poor AD-DA converter be circumvented by connecting an

S/PDIF interface to the DSP port (see the chapter "Installation"). This would

prevent loss during data transfer with CD players or DAT recorders and also

allows sample frequencies of 44.1 and 48.0 kHz which are standard in high-end

equipment.

The hard diskHard disk recording demands high performance from the connected hard disk: In

order to work comfortably with eight tracks at the highest sampling frequency, the

data transfer rate should not fall short of 1.4 MB per second.

Direct to DiskThe program is tape-orientated, meaning that operation is similar to an eight track

tape recorder. There is no complicated data handling - one or more partitions

which have been declared to be "tape" can be recorded to directly. Unlike real

tape recorders, the number of tracks can vary from song to song.

EditingApart from standard features such as accurate locator points for Punch In/Out

(precision is to the nearest sample!) or record and playback in cycle mode, there

are numerous functions used for editing the recorded material afterwards. These

can be divided roughly into two types: structural operations for extracting, copying

or moving sections of music which manipulate the data on the hard disk directly

(destructive editing) and precision work using the wave editor's graphic display,

whereby you can decide whether any changes should become permanent at a later

point in time (non-destructive editing). Up to four tracks can be edited

simultaneously. The editor offers block functions which can even be called during

playback and also non-destructive recording in cycle/overdub mode.

MixingProductions can be mixed down either by using the integrated mixer or, by way of

the Falcon Analog-8 interface ("FA-8") or Adat Interface, using an external mixing

desk. AudioTracker can be synchronized to sequencers or other time-dependant

equipment using standard MIDI Time Code or MIDI Clock - several Falcons can

be linked to form a theoretically unlimited multitrack system via a special internal

synchronization protocol.

Backup and archivesExport and import functions allow data to be transferred to and from other audio

programs - an integrated streamer function caters for backups and archiving single

partitions to DAT.

AudioTracker - Introduction 1.1 Introduction

-5-



-6-



Installation and Program Start

2.1 Hardware Configuration

Safety copy / Running from

hard disk

The AudioTracker floppy disk is not copy-protected - you should make a safety

copy of the disk before you do anything else. If you want to start the program from

your hard disk you should create a new folder (e.g. A_TRACK) and copy all files

into it (from the safety disk of course!).

SCSI driverUsers of SCSI disks should copy the driver "SHDRIVER.SYS" into the root

directory of the boot drive (usually C:\). The existing driver will be overwritten

(quit the alert box with "Copy"). The original SHDRIVER.SYS may be write

protected - in this case select the file and delete its read-only attribute via the

menu File/Info first. Only the AudioTracker version of this driver lets you work

with eight tracks properly. It will work as a standard AHDI driver for other

programs - the special functions are only activated by AudioTracker.

IDE driverIf you work with an IDE drive, the kind of Harddisk driver is not important,

because AudioTracker has special code implemented to use IDE-drives in the

fastest possible way.

Program font / NVDIAudioTracker cannot install its own font if you are running NVDI. This is no big

problem, but for the sake of completeness you should know how to install the

program under NVDI because the font engine (which is not often used by other

programs) contains special characters which make the program look a lot tidier.

Copy the font "A_TRACK.FNT" from the folder "A_TRACK.DAT" to the

directory which contains the NVDI driver "NVDIDRVx.SYS". As a rule this

should be the "GEMSYS" folder. Further action differs according to whether the

file "ASSIGN.SYS" is present or not:

a) Installation when "ASSIGN.SYS" is present

Extend the file "ASSIGN.SYS" by writing the name of the new font to it, by using

the NVDI tool "ASSIGN.PRG". Any ASCII text editor can be used instead - you

should enter "s A_TRACK.FNT" into the list under "05p SCREEN.SYS" and save

the file.

b) Installation when "ASSIGN.SYS" is not present

The program disk includes an "ASSIGN.SYS" file which already contains all the

necessary information to run AudioTracker, but assumes that the

above-mentioned NVDI driver is in the "GEMSYS" folder - if not you should set

the path accordingly by loading it into an ASCII editor and changing the "PATH

=" entry.

Installation and Program Start 2.1 Hardware Configuration
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Monitor / screen resolution AudioTracker will run at all screen resolutions from 640 x 400 upward except True

Color.

Copy Protection - the key AudioTracker is protected from illegal use with the aid of a hardware key or

"dongle", which should be inserted into the ROM port of your Falcon (to the right

next to the MIDI sockets) with the marked side visible.

Hardware configuration Operation without a Digital Interface

If you own the special digital interface (either the Soundpool one from your

AudioTracker dealer or an original Steinberg) you can skip this section. Connect

the Falcon's headphone socket to your stereo system - you will usually need a

"stereo mini-Jack to double Cinch" cable, or plug headphones directly into the

Falcon. If you want to record using a microphone you should connect this directly

to the Falcon. Low-impedance analog sources such as tape decks, CD players or

most keyboards can be adapted by connecting a 200 Ohm resistor in series with

the signal line (in two special Jack leads would be a good place if you are handy

with a soldering iron) - ask your dealer if in doubt. Switch on all connected

equipment and boot the Falcon.

Operation with S/PDIF and FA-8 interface

As already mentioned in the first chapter, this configuration (or similar) is

necessary if you want professional quality sound. The cost of the additional

hardware is relatively low if you compare it with the price of dedicated hard disk

recording systems. A digital audio tape deck (e.g. DAT recorder) is necessary for

the following reasons:

2.1 Hardware Configuration Installation and Program Start
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° Analog recordings are converted to digital with the high quality AD converter

in the DAT recorder and sent without loss to the Falcon. The sample

frequency is dictated by the DAT (usually 48 kHz). You can also record

directly with 44.1 or 32.0 kHz using Soundpool's new Sample Rate Converter.

° The finished pieces can be mixed to stereo using the integrated mixer and can

then be digitally mastered to DAT tape without any loss of quality whatsoever.

Subsequent editing (e.g. with "AudioMaster") will not impair the sound at all

as long as the "digital chain" is not interrupted.

° The system can also be used as a comfortable data streamer - digital data is not

restricted to audio.

The S/PDIF interface is connected to the ANALOG-8 interface via a short ribbon

cable and also to the Falcon's DSP port with a special cord which is included in

the package.

The S/PDIF actually has two interfaces, coaxial and optical. Coaxial connections

need well shielded Cinch cables - optical connections are made using special

cables which are available from better Hi-Fi dealers. The second method is

preferred as, apart from better quality sound, loss of data during use as a streamer

is avoided. Connect the S/PDIF digital input to the DAT or CD digital output and

the S/PDIF digital output to the DAT's digital input. Turn on the power to the

FA-8 and connect either all the analog outputs (1-8) to a mixing desk or channels

1 and 2 to the left and right line-in sockets of your Hi-Fi system.

2.2 Starting the Program

Before you start the program you should decide on the partition of your hard disk

which you want to reserve for audio data. The chosen partition should not be too

small - approximately 5 MB is used per minute for each track sampled at 44.1 kHz.

A ten-minute song with eight tracks sampled at 44.1 kHz requires 400 MB (440

MB at 48 kHz) of valuable hard disk memory!

If you own a 1 or 2 Gigabyte hard disk you can start thinking about separating it

into two or more partitions for the sake of clarity. Each "tape" can accomodate up

to 16 songs. If most of your work is comprised of short jingles, partitioning such a

large hard disk can be very sensible.

Start the program by double-clicking on "A_TRACK.PRG". A new desktop with

the program logo, menu and tape transport pad will appear after a few moments.

The transport pad includes a display showing the song position and locator

positions as SMPTE times (hours, minutes, seconds and frames). The current

sample frequency and source are displayed to the right. Only the Falcon's internal

frequencies are shown (e.g. "49.2 kHz / INT") if the interface is not connected.

Otherwise the sample frequency of the external source device (48.0, 44.1 or 32.0

kHz, "EXT") appears. If there is a period in front of the word "EXT" this means

that the external device is sending at 32.0 kHz which cannot be generated by the

S/PDIF. In this case the program will switch automatically into the (otherwise

optional) external clock mode - more on this subject in the next section.

To the left of the display are the tape controls, the function keys "Punch In",

"Punch Out", "Cycle" and "Sync". At the far right you will find a clipboard used for

temporarily saving any musical snippets.

Installation and Program Start *+2 S,69t:;< th= >r?gra@
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2.3 Software Adaptation

Audio Parameters Window Select "Audio Parameters" from the Options menu to adapt the program to your

hardware configuration. Most of the parameters are automatically preset to

sensible values when the program is loaded - the program recognizes whether the

S/PDIF interface is connected and also what frequency the digital input is

receiving. A window appears in which the following parameters can be set. These

settings are loaded when a new song is created, but can of course be changed at

any time. The current settings are saved automatically when the song or the

program is removed from memory.

Input You can only record either via the Falcon's own AD converter (microphone

input) or by way of the digital interface S/PDIF or ADAT. Click on the

corresponding button. If the S/PDIF interface is not connected you will not get a

choice - "ADC" will be selected by default and the other buttons will be disabled

(greyed). If you want to record via the ADAT-8- Interface, you may select either

one of four possible stereo pairs or all channels 1-8 by the pop up menu

"ADAT-BUS". There are two buttons beside these with which the input channel

can be selected. Two neighbouring channels will be recorded to in STEREO

mode i.e. tracks 1+2, tracks 3+4 etc. Choose the mono channel to which your

instrument or microphone is connected if you wish to record single tracks.

Output The mixer is able to send the output signal in two basically different ways.

STEREO mode lets you to mix all tracks to a stereo sum using the integrated

mixer which can then, for instance, be digitally mastered to a DAT recorder. If an

FA-8 is connected, the right channel will appear on output 1 and the left channel

on output 2. The "CHANNELS" setting causes the output of all tracks to be

routed to the corresponding analog outputs of the FA-8 so that they can be mixed

using an external mixing console (the panorama control would then be missing

from the internal mixer). This mode allows you to assign one stereo pair to the

D-A- Converter of the Falcon (headphone socket) by the pop up menu

"DAC-BUS". So it is possible to lead out six resp. four single channels without

using the FA-8 or ADAT-Interface.

Sample Rate Either the Falcon's internal frequencies or those from the S/PDIF (or other

connected clock) are available, depending upon the output setting. The S/PDIF

offers 44.1 kHz and 48.0 kHz. If you want to synchronize the system to an external

clock you should select the button labelled "EXTERNAL CLOCK". The button

will always display the most recently measured clock frequency. Measurement

occurs when the program starts , after digital recording and also after playback.

Digital recordings via S/PDIF will always run at the speed of the source device and

will not be influenced by the chosen sample rate. You will find more information

on this subject and its inherent problems in the chapter "Digital Recording".

Effects The DSP (Digital Signal Processor) is an independent CPU that allows to work on

the audio signals in realtime. This unit calculates the level and panorama position

and is able to process some effects. The current program version includes a reverb

module, a Dual 9-Band-EQ and a gate. Select the desired module out of the pop

up menu "DSP". One or two of the effect parameters can be controlled in the

mixer window - for editing the basic parameters you should use the effect editor

window.

The effects can also be processed "offline" (refer chapter 10.2).

2.3 Software Adaptation Installation and Program Start
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The First Recording

3.1 Brief Tutorial

It is a good idea to be introduced to the general flavour of the recording

procedure without having to wade through a list of all the available functions - this

chapter covers enough ground so that you can make something audible within a

few minutes. If you are not in such a hurry and would like to study the concept

and operation in depth you can skip this chapter and read the rest of this manual

(where all functions are explained more fully).

Installing a "tape"A "tape" must be installed first. Click on "Install Tape" in the "File" menu and then

select the drive/partition you want to use for HD-recording. All registered hard

disk partitions are selectable.

The minimum amount of a tape file should be 4000 kB!

Quit the dialog box with [OK]. The [Cancel] button is the default (i.e. can be

activated by pressing RETURN or ENTER) for safety's sake. If the partition

already contains data you will be warned with an alert box. Any such data will be

erased as soon as you confirm with [OK]. The message "Tape installed" will

appear after a few moments: the message box will disappear automatically after a

few seconds or when you move the mouse.

The first songYou can set up your first song. Select "New Song" from the "File" menu. A dialog

box will open in which you can set the following:

° Song Title: Enter a name for the song and hit ENTER.

° Tracks: Enter the number of tracks

° Time: Enter the length of the song. The maximum length possible is already

entered by default. You should reduce this by about 10 seconds to leave

enough room in memory for the clipboard functions. Quit the dialog either by

hitting RETURN or by clicking on [OK].

The Mixer window will be opened. To the left is the master section, to the right the

mixer module. You can now start the recording.

RecordingEach track corresponds to a module in the mixer. Select a track to be recorded to

by clicking on one of the buttons below the faders. Click on the record button in

the tape transport pad. Play something on the connected instrument or start the

tape/CD you want to record. The peak meter should average about -12 dB. Purely

digital recording will not allow you to manipulate the level - if an

microphone/instrument is connected to the analog input of a DAT recorder you

can control the level there (DAT in RECORD/PAUSE mode). The default value

is "MONO/Left".

The First Recording 3.1 Brief Tutorial
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If you want to record in stereo or just the righthand channel, click on the stop key

(to the left). Press Control+A on the keyboard or select "Audio Parameters" from

the Options menu. A window will open in which you can select the required input

mode. You can now select the track(s) you want to record to (stereo mode always

records to pairs of adjacent tracks). Start the recording by clicking on the Record

button or by hitting the "*" key on the numeric pad of your keyboard.

Set the faders in the mixer and the master fader to the required levels. If you are

recording stereo you should set the pan controls to the extreme right and left. To

finish recording click on the Stop button (pressing the spacebar or 0 on the

numeric keypad will have the same effect). If you don't actively stop the recording

it will terminate automatically at the end of the period set in the dialog box you

opened with "New Song".

Playback Using the Play buttons, select the track(s) you have just recorded and rewind to

the beginning by clicking on the Rewind button or by pressing Contol+( on the

numeric keypad. Click on the Play button or press ENTER to start playback.

Record-Button and Play-Button

3.1 Brief Tutorial The First Recording
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Musical Structures

4.1 A Few Definitions

TapeA "tape" is the basic structure and corresponds to a tape file on the hard disk. The

decision of whether you want to work with a single large partition or several

smaller ones is left up to you. Tapes are installed by selecting "Install Tape" from

the File menu and is the first action to be taken when setting up the system.

SongA tape can accomodate a maximum of 16 "songs". New songs are are declared via

"New Song" in the File menu - you will need to set the length and number of

tracks. "Open Song" activates a previously recorded song for further editing. Songs

are handled in a similar way to standard files although they are not GEMDOS

structures. Songs cannot be loaded as standard files by other programs and cannot

be deleted or copied by normal means. Such actions are carried out by dedicated

functions which will be described in later chapters.

TrackA song consists of two to eight "tracks". Each track has a corresponding mixer

module in AudioTracker's main window, which is used for setting volume level,

panorama, effect-balance and record/playback. The "Structure" Menu contains

functions for copying and deleting single or multiple tracks. The number of tracks

in a song can be changed at any time.

PartA "part" is a musical passage of a song as defined by two locator points - it is not a

subdivision of a track but of the entire song across all tracks. Nearly all structural

operations such as Delete, Cut, Copy, Paste, Punch-In recording, Cycle-Mode

recording manipulate "parts". You can set the tracks to be included in the

operation with the Play/Record buttons.

A tape with 3 songs of different length and number of tracks

SMPTE time codeThe SMPTE standard (EBU) time code has, in addition to the usual time intervals

hours, minutes and seconds, a further subdivision of the second into 25 so-called

"Frames". Almost all the editable fields and displays in AudioTracker are

concerned with SMTE time.

Musical Structures 4.1 A Few Definitions
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Samples Samples are the smallest musical units which make up a sound. The Wave Editor

allows access to single samples and lets you position the songpointer or locators to

single samples. The number of samples per second is called the sample frequency

or rate - a sample frequency of 48 kHz means 48000 samples per second.

4.2 Creating and Manipulating Structures

Installing a tape AudioTracker is only ready to record for the first time after a "tape file" has been

installed on the hard disk. This only has to be done once except if you want to use

this function to delete all the songs in the file.

Click on "Install Tape" in the File menu. A dialog box will open which contains a

row of buttons from "C" to "P". All drives which are registered in the operating

system are selectable, all others are greyed. A drive may already selected, but if

you wish to change this you should select the right drive by clicking on the

appropriate button.

There is an editable field below the drive letters in which you can write a name -

this is usually used to name backups made using the streamer function. Quit the

dialog box with [OK] after making sure that you have selected the correct

partition. AudioTracker creates a file with the name "A_TRACK.TPE".

Remember: If you attempt to load, move, copy or edit the file "A_TRACK.TPE" in

any way from the desktop or from within other programs and you get trouble, use a

defragmentation tool on the tapefile.

All the dialog boxes in the program are "flying dialogs" i.e. they can be moved

freely across the screen. Click on the blue title bar and drag the dialog to the new

position while keeping the mousebutton pressed. The current position of each

dialog box is saved when it is closed, to be restored the next time that particular

function is called.

New song Clicking on "New Song" in the File menu will open a dialog box in which you can

set a few parameters to define the song:

° Firstly, select the tape using the drive buttons. If you are only working with a

single tape this partition will already be selected. Only partitions which have

been installed as tape will be selectable - all others are greyed.

° Down left the data transfer rate of your harddisk drive is displayed. For full eight

track performance this value should be higher than 1300 KB/s.

Tip: If you need more speed change to the monochrome display mode.

° By default, the text cursor is in the editable field in which you can write the

title/name of the song. Enter a descriptive name and hit ENTER.

° Select the number of tracks you will need for the song. The field next to the track

buttons shows the approximate free capacity of the tape, displayed as time.

° Enter the length of the song in hours, minutes and seconds (hh:mm:ss.

4.2 Creating and Manipulating Structures Musical Structures
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The [OK] button becomes the default after all the parameters have been entered -

hit RETURN again or click on [OK] to quit the dialog.

AudioTracker's main window is opened, containing a mixing console whereby

each mixer module represents a track. If your song has eight tracks they can only

be displayed simultaneously if the resolution of your monitor is at least 640 pixels

wide. The mixer will be described fully in the chapter "The Integrated Mixer".

Opening a songA song can be opened for editing by clicking on "Open Song" in the File menu. A

dialog box similar to the standard file selector will appear. To the right is a row of

drive buttons from which you can select the tape. All the names of songs on the

selected tape will be listed together with information about the number of tracks,

the sample frequency and the size of the file expressed in hours, minutes and

seconds. Select the required song and quit the dialog with [OK] - double-clicking

the song will have the same effect.

If a song is already active, all its windows will be closed first. All important settings

will be saved automatically so that the old song can be restored later. The main

window of the currently selected song will then be opened.

Closing a songExcept for one particular reason (see "Deleting a Song") you should never need to

close a song - AudioTracker will do this automatically whenever it becomes

necessary. Songs are closed when their main windows are closed. Alternatively,

hitting ESCAPE will also close the window. Closing the main window of a song

will of course close any other windows belonging to that song.

Deleting a songThe function "Delete Song" lets you erase the song from the tape. Not only is the

music deleted, but any following songs will be repositioned so that all the free

memory on the partition will be in a single block at the end of the tape. This may

take a while, depending upon how much data has to be moved. Deleting the last

song on tape is immediate. If a song other than the currently active one is to be

deleted, you should close the main window before you call this function. The song

selector will be opened (as if you had called "Open Song").

You will always be warned before a song is finally deleted so that you have the

chance to cancel the action. A horizontal bar similar to that seen while formatting

diskettes displays progress so that you can estimate the time required.

Changing song structureThe structure of the currently active song i.e. the length and the number of tracks

can be changed at any time using the function "Song Structure" found in the

Structure menu. The dialog seen when calling "New Song" is opened in which you

can change the parameters. The field showing the length of the song will change

according to the number of tracks you enter. When you are satisfied with your

entries, quit the dialog box with [OK]. Data may have to be copied/moved

according to the changes you have made and depending upon the position of the

song on the tape (see above). All windows will then be closed. After all the

necessary actions have been carried out, the main window will appear again - if

you have changed the number of tracks the number of mixer modules will be

changed accordingly.

Musical structure operations on tracks and parts are explained in the chapter "The

Structure Menu".

Musical Structures GH2 CJKNQUVg andXanipYZating [tru\ture]
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The Tape Transport Pad

5.1 Tape Control

The left side of the pad contains buttons used for controlling tape transport. At

the top are STOP, RECORD and PLAY, below these are buttons for fast-rewind

and fast-forward. The outer buttons will set the song pointer either to the next

locator in that direction or to the beginning or end of the song. The inner buttons

move the "tape" either in steps of seconds (with the left mouse button) or frames

(with the right mouse button).

Playback / StopPlayback is started either by clicking on the PLAY button or by hitting

ENTER/RETURN on the keyboard. If the song pointer is already at the end of

the song it will jump to the start automatically (not during RECORD). Only those

tracks whose PLAY buttons are selected will be played back (see "The Integrated

Mixer"). Playback is stopped either by clicking on the STOP button or by pressing

the spacebar (or 0 on the numeric keypad). The song will also stop when it reaches

the end, of course.

Note: If your hard disk is relatively slow , you might be warned of the fact with an

alert box ("Maybe HD too slow!"). One reason can be that you have selected too

many tracks for playback. If you ignore the message you run the risk of having

playback interrupted abruptly in the middle of the song ("HD too slow!").

If one of the above messages appears although you are running a SCSI disk you

are either using the wrong HD driver ("SHDRIVER.SYS") or you have chosen a

horizontal resolution of more than 640 pixels in 16 colour mode (cf. the chapter

"Installation and Program Start").

Song positionThere are other ways of changing the song pointer other than with the transport

controls:

° Double clicking the song position display opens a small field in which a new

position can be entered in SMPTE format. Confirm either by hitting RETURN

or by clicking within the field.

° A single click on the display calls a popup list containing up to ten

user-definable cue positions. These can also be selected by hitting the function

keys together with SHIFT. The current song position can be saved to one of

these cues by holding down CONTROL whilst selecting the cue. For instance,

you can press CONTROL + SHIFT + F4 to save the current song position to

cue number 4. The cue list belongs to the parameters which are saved when the

song or the program is terminated (see Appendix).

° When the Wave Editor is open the song pointer can be placed within the

sample display by CONTROL + click in the position bar (see the chapter

"The Wave Editor: The Song Pointer and Locators").

° Using the keys "[" and "]" the songpointer will be placed to the position of the

left resp. right locator.

The Tape Transport Pad 5.1 Tape Control
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Left and right locators The two locators are flexible cues used for delimiting a musical passage. Such a

passage is called a "Part" in AudioTracker . There are functions in the Structure

menu for copying, moving and deleting parts. The positions of the left and right

locators define the start and end of playback/record in Cycle mode and also the

Punch-In and Punch-Out positions during normal record. The locators can also be

positioned in several different ways:

° By entering the position in SMPTE format after having double-clicked on the

corresponding display.

° There are ten user-definable locator-pairs which can be defined and restored in

a similar way to the cues (see above) but without pressing SHIFT.

° Locators can be set during playback by hitting the left or right SHIFT key.

AudioTracker confirms this with the message "SAVED!" in the locator display.

The exact position will be calculated and displayed after playback is stopped.

° The locators can also be positioned in the Wave Editor by clicking on the left or

right mouse buttons.

Note: Playback or record in Cycle mode only works if the locators are at least 2

seconds apart otherwise the cycle button will be disabled. This does not apply to

loops in the Wave Editor.

5.2 The Display

The middle of the tape transport pad is a field showing the song position and

locators in SMPTE times (hh:mm:ss:ff).

Next to the song position is a record mode indicator (REC-MODE). "REPLACE"

is the default mode. When cycle mode is activated, this will switch to

"OVERDUB". More on this subject in the chapter "Further Record and Playback

Functions: Cycle Mode"). To the far right is the display for the selected or

measured sample rate. Below this is an abbreviation representing the clock: "INT"

means the Falcon's internal clock, "EXT" means the clock in the S/PDIF interface

and "*EXT" means another external clock (see the chapters "Installation and

Program Start: Software Adaptation" and "Recording: Digital Recording from CD

or DAT").

5.3 Function Control

To the right of the display are four buttons used for calling the following functions:

Punch In Record with the left locator as preprogrammed "start recording" switch.

Punch Out Record with the right locator as preprogrammed "stop recording" switch.

Cycle Record or playback in a loop delimited by the locators.

Sync Switches on the synchronization mode as defined in the corresponding dialog box.

A more comprehensive explanation of these functions can be found in the

chapters "Further Record and Playback Functions" and "Synchronization".

5.2 The Display The Tape Transport Pad
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The Integrated Mixer

All audio output is routed through the integrated mixer. The mixer (in conjuction

with the tape transport controls) allow access to all functions related to recording

and playback.

Depending upon the output mode (Stereo/Channels) set in the audio parameter

window, the output will either be a stereo sum or individual tracks which will be

routed via the FA-8 interface to an external mixer. Alternatively, the mixer can be

used as an online effect processor or for "bouncing" tracks together internally

(without loss of quality!) to one or more tracks (thus reducing the number of

tracks).

The mixer's user interface opens whenever a song is loaded or a new song is

created. The mixer window will remain in the desktop until the song or the

program is terminated.

6.1 Window Handling

The mixer window can be moved - like any other window - inside the borders of

the desktop (exept the tranport pad) by clicking on the titel bar and dragging by

keeping mousebutton pressed. You may choose, whether you want to do this in

"full view mode" (left mousebutton) or - as well as known - or in "outline mode"

(right button).

° The closebox at the top lefthand will not only close the window, but will

terminate the song and close any other window. All song parameters will be

saved to harddisk.

Additional, all windows are provided with a button for "iconifying". Clicking on

this button, the window will be shrinked up to minimal size and will appear at the

buttom of the desktop. A single click on it will resize and place it to the previous

position.

The Integrated Mixer 6.1 Window Handling
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6.2 Master Section

The lefthand side of the mixer is the master section. The information bar at the

top displays the name of the song and will open a "song info" box when clicked on.

On the bottom is an option bar where the audio monitor and peak meter can be

enabled/disabled. Switching off the peak meter can be sensible if your hard disk is

slow - the system will be relieved of some (not so important) work.

You can see the option bar on the left side.

Mixer mode The mode button to the right will open a popup menu from which you can choose

one of the following:

° Normal: Mode used for normal recording and playback.

° Mixdown: This mode is used for bouncing tracks together to one or more tracks

(see the chapter "Playback and Record Functions: Mixdown").

° Online: If online mode is selected, the input signals will be routed directly to the

mixer inputs. AudioTracker then works as a stand-alone mixer and/or effects

processor.

Peak meter The input levels are displayed as left and right peak meters (as pseudo LED

columns directly below the options bar on the left). Depending upon the output

mode, the output levels on the right will either be for the left/right channels

(output mode "Stereo") or for each individual track (output mode "Channels").

The peak meter has a "peak freeze" feature so that you can check for maxima. The

optimum level should be within the yellow area (-12 dB to 0 dB) - if the top (red)

segment lights up the signal level is too high. The peak meter will only be working

if the mixer window is active (in the foreground) and the peak button in the

options bar is enabled.

Output Control The master fader sets the output volume up to +6 dB. The 0 dB level can also be

set by clicking on to the [0] sign.

A-D/D-A If you want to record by using the Falcon's A-D-Converter (microphone socket),

you may control the input gain with the pots MIC L and MIC R. These pots can be

"turned" by clicking on them and moving the mouse in horizontal or vertical

direction while keeping the mousebutton pressed.

Below these pots you find a further pot to control the output signal of the

headphone socket.

6.2 Master Section The Integrated Mixer
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6.3 The Track Modules

Ejqx z{ac| }~ th� ��n� has its o�n �i�er mo���e� �ou can name each track ��

clicking on the bar at the to� o� each module. Mixer modules contain some of the

following elements� depending upon the �udio Parameters settings:

ReverbIf re�erb is active, there is a control for the effect�send of each track. Global

parameters are set using the Effect Editor �activated via the Edit menu�.

In �hannel mode, the effect return channels can be selected with the return

button beside the effect send fader. If this button is not activated the channel�s

output is 'dry'.

EQIf EQ is active, there is a fre�uency selector and a gain fader to control the

frequencies level. Graphical settings can be made in the EQ Effect Editor

GateIf Gate is active, the threshold can be controlled by the effect- fader. �he button

�gate" switches the gate on�off. The other gate parameters can only be edited using

the effect editor (refer chapter �0.2)

PanoramaIf output is stereo the panorama positions of eack track can be set using the pan

pots. These pots can be turned by clicking on them and moving the mouse in

hori�ontal or vertical direction while keeping mousebutton pressed (right or

downwards: - R; left or upwards: - L). There are three small buttons to set

position extremely left, right or center with a single mouse click.

° The pan pots will not appear in "Channel" mode.

° If an �A-� interface is connected its outputs 1 and 2 correspond to the left and

right stereo channels.

° �killful combinations of reverb and pan can be used to position tracks in virtual

space very effectively.

LevelThe vertical level faders regulate the relative output levels of each track. The

overall level is controlled using the master fader (see above).

In "Channel" mode the  SP module "No Effect" offers a bypass switcher that can

be activated separately for each track. The audio signals of these tracks will not be

manipulated by the the level faders. If you set the master fader to 0 dB, you will

get a 1:1 transmission. Additional, the physical output of each track can be

changed. If a double setting is made, you will get a short message when you move

the mouse out of the window borders. A quick way to renumber all outputs in

increasing sequence is to click on the output box of the track that you want to

assign to output 1 while keeping pressed "CONTROL".

Main parts of the mixer can be controlled via MIDI. Refer chapter 11.3

"Synchronization" for details.

¡¢£ ¤¥¦e§¨©teª «¬­er ®¯3 The Track M°du±es
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Fader Groups The trackmodule level fader can be combined to fader groups. One group consists

of one master and a various number of slaves faders. You can define a master for

two groups (A and B) by holding the ALT key (for the A group) and clicking on

the desired fader with the left mouse button. On the fader an "A" appears and the

fader's color turns to green (in color mode only). In the same way you define some

other faders that will now work as slaves. Do the same for the "B" group by holding

the CTRL key instead the ALT key. Now you can move the master fader - all

slaves will follow but always keep their relative position to the master fader. Move

the master with the right mouse button and the slaves will take over the master's

position, but the relative position will not be lost. When moving the master fader

with the left mouse button again the old positions will be restored. Slaves can be

moved separately.

To cancel the fader group "A" hold the ALT key and click on the master "A" fader

with the right mouse button. In the same way you can quit a fader's slave status. As

long as a group with master fader exists you can define new faders as a slave.

Record / Play/Wave The record (REC) and playback (PLAY) buttons are situated at the bottom of

each module. If the play button is switched off the track will be muted. A track

cannot be in both "record" and "play" at the same time if the mixer mode is set to

"Normal" i.e the buttons are mutually exclusive. If you are recording in stereo

mode, activating the "record" button of a track will also activate the neighbouring

track's record button (tracks 1+2, 3+4 etc. are linked). These two buttons are

also used for selecting the source and destination tracks for structural operations

(copying, deleting etc.) and for audio import/export.

Selecting a "record" track and a "playback" track.

The wave button selects all tracks who are used in the wave editor.

6.3 The Track Modules The Integrated Mixer
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Recording

7.1 Preparation

The following instructions have been written assuming that you have already

opened a song and have set all the necessary software adaptation (in the "Audio

Parameters" window).

Rewind the "tape" to the required song position and switch on the "REC" button of

the track you want to record to. Remember that stereo mode cause adjacent

tracks to be activated.

Please secure that the mixer is in normal mode.

Analog recording via DAT

recorder

Connect the instrument or microphone to the DAT machine's analog input and

set the DAT to RECORD/PAUSE (record mode = analog). Click on the record

button in AudioTracker's tape transport pad - the program will also switch to

RECORD/PAUSE. Set the input level on the DAT machine - the DAT and

AudioTracker levels should be identical or similar. Make sure that the levels are

between -12 dB and 0 dB (within the yellow range) when you are playing the

instrument.

Note: Unlike normal analog recording systems, 0 dB should NEVER be exceeded,

otherwise the signal will be digitally distorted!

Digital recording from CD

or DAT tape

DAT tapes and CDs will usually be recorded in stereo mode. You may have to

check the input mode setting in the Audio Parameters window. Digital to digital

recording does not require levels to be set.

Recording from the

microphone socket

Connect the instrument/microphone to the Falcon's microphone socket. Click on

Record (transport pad) and set the input level using the faders from the audio

parameter window.

7.2 Starting Recording

Recording the first trackIf AudioTracker is still in RECORD/PAUSE, simply click on the PLAY button to

start the "tape". Otherwise you can start recording directly by either clicking on

RECORD with the right mouse button or by hitting the "*" key in the numeric

keypad of your keyboard. You can listen to the output of the integrated mixer if

the audio monitor is switched on (options bar), whereby level, effect send and

panorama can be changed without affecting the recording. Finish recording with

either the STOP button in the tape transport pad, the spacebar or 0 (numeric

keypad). You can then rewind, switching on the "play" buttons of the appropriate

tracks and click on PLAY to listen to the recording.

Recording 7.1 Preparation
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Recording further tracks Recording further tracks whilst listening to tracks you have already recorded

follows the same principle - select the "play" buttons of the tracks you want to hear

and the "record" buttons of the new tracks you want to record on.

Note: If your hard disk is relatively slow you could get the message "Maybe HD too

slow!" when you start recording. One reason could be that you have selected too

many playback tracks. If you ignore this message you run the risk of the recording

being aborted with the alert "HD too slow!". If one or both of the above messages

appear although you have a SCSI disk you have either not replace the original HD

driver ("SHDRIVER.SYS") with the one on the AudioTracker floppy disk or you have

selected a horizontal screen resolution above 640 pixels (16 colour mode) - see the

chapter "Installation and Program Start".

Do not assume that, for instance, "my disk can play five tracks back so I should be

able to listen to three tracks while recording in stereo" - write operations to disk

(record) are usually much slower than read operations (playback)!

Monitoring If you are recording/playing back via the Falcon's internal ADC/DAC and the

audio monitor is on (mixer window), the signal being recorded will be mixed with

the output signal to the headphones. Recording via external ADC (e.g. DAT

machine) and S/PDIF is a bit more complicated: the current Falcon's hardware

does not allow playback signals and record signals to be routed through the

integrated mixer at the same time. Therefore you will have to use an external

monitor line: connecting the LINE OUT of the DAT machine (which carries the

record signal) and the analog outputs of the FA-8 to an external mixing desk lets

you create an individual "monitor-mix" for the instrument player's headphones

(see the diagram "Professional configuration" in the chapter "Installation and

Program Start").

If you don't have access to a mixing desk you could conceivably make a simple

Y-lead to connect the outputs to the amplifier, but audio engineers will probably

tell you that this is not good practice!

7.2 Starting Recording Recording
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Further Record and Playback Functions

8.1 Punch In / Punch Out

Punch in recordingThese functions are used to switch in and out of record mode automatically - the

locators are used to delimit that part of the song which you want to record.

Select the Punch In button in the tape transport pad by either clicking on it with

the mouse or by hitting the "I" key and rewind to a position before the left locator.

Choose a track to be recorded to and start recording (see previous chapter). The

RECORD button will be switched off automatically as soon as the "tape" is

running and will remain so until the position of the left locator is reached. At this

point the RECORD button will switch itself on and the track will be recorded to.

You can terminate recording either manually or by using the right locator as

Punch Out.

Punch out recordingSelect the Punch Out button by either clicking on it with the mouse or by hitting

the "O" key. Start recording from a position to the left of the right locator (either

manually or punch in). The program will switch to playback mode automatically as

soon as the right locator is reached.

Combining punch in and punch out is very useful for improving faulty sections in the

middle of recordings which are otherwise good. The section to be re-recorded can be

defined very precisely using the Wave Editor and its "snap" functions (see the chapter

"The Wave Editor").

8.2 Cycle Mode

A part of the song can run as an "endless loop" in both record or playback modes.

The part is, again, delimited by the left and right locators.

Cycle mode is activated by clicking on the Cycle button in the tape transport pad

or by hitting "C" on the computer keyboard. The button is disabled (greyed) if the

locators are too close to each other. The minimum distace between the locators is

about 11 seconds. Shorter loops can be defined within the Wave Editor.

Recording in cycle modeRecordings in cycle mode can only be started at the left locator - the song position

will jump to the left locator if necessary. If you decide later that you want to record

normally again you should switch off cycle mode first.

Cyclic recordings are always overdubs ("replace" mode would not be sensible

here) - the record mode display will be changed accordingly. Overdubs will not

erase any previous material on "tape" but will be added to it. You can start

recording as usual and add to the existing part again and again, thus building up

complex rhythms, for instance. Other tracks in playback mode can still be listened

to while you are recording in cycle mode.

Note: Excessive use of this feature is not recommended if you are using the Falcon's

internal ADC because this converter is rather noisy - each cycle will add noise to your

recording which can quickly become intolerable. The same applies to noisy audio

sources - you should keep the number of cycles to an absolute minimum if you are

concerned with the quality of your recordings.

Further Record and Playback Functions 8.1 Punch In / Punch Out
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Cycle mode and punch in/out are, by nature, mutually exclusive. Recording is

carried out in volatile memory and is "nondestructive".

Playback in cycle mode Playback can be started at any position. The song position pointer will jump back

to the left locator as soon as the right locator is reached. This feature can be used

for fading "repeats" at the end of a song. Cyclic playback is also helpful for

rehearsing a passage you want to record or for testing various mixes.

8.3 Mixdown

You can "bounce" several tracks together to one or two free tracks so that you can

delete the originals (thus saving tracks) and/or make any internal effects

"permanent". The mixer output in mixdown mode serves as a digital source and

therefore you cannot record (normally) at the same time.

Example:

You have created a song with six tracks. Tracks 1 to 4 contain various drums which

you want to mix to a stereo sum. Click on the mode button in the master section of

the mixer window and select "Mixdown" from the popup list. If cycle or punch

functions are on, switch them off and rewind the "tape" to the beginning of the

song.

Select tracks 1 to 4 for playback and tracks 5 and 6 for recording (you may have to

switch to stereo mode via the Audio Parameters window first). Start playback if

you want to do a test run first (and then rewind again).

The fader positions of the record tracks are not important - they are ignored. Start

recording as usual. Everything you hear will be recorded to tracks 5 and 6 i.e all

mixer parameters and changes to tracks 1 to 4 will be included.

When you are mixing down to a single track, take care to set the pan sliders of the

source tracks to the extreme right or extreme left, depending on the input channel

as set in the Audio Parameters window.

8.4 8 Channel recording

If you select Adat in the audio parameter window you can record up to 8 tracks

simultaneously. The adat bus mode defines which channels will be used as inputs

(8 inputs or 2 inputs). If you only want to playback 8 channels to the ADAT

interface you don't have to select ADAT. The ADAT interface behaves like FA8.

If you want to mix the 8 channels use the Online function in the mixermode.

Please note: in 8 channel recording mode you need a fast harddisc. IDE drives will

give best performance on AudioTracker.

8.3 Mixdown Further Record and Playback Functions
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The Wave Editor

AudioTracker's wave editor allows nondestructive editing - all operations are

carried out in memory and therefore can be aborted at any time. The display can

be scaled and allows access to each sample for smooth cuts and loops. The editor

has its own separate audio functions for recording in cycle/overdub mode and for

real time acoustic monitoring of the results.

Your computer should be equipped with enough memory to handle the

nondestructive editing - 4 MB RAM is minimum. If you have at least 4 MB but still

get the message "Not enough memory!" you may have to remove unnecessary

resident programs e.g. complex screen saver or large accessories.

9.1 Calling the Wave Editor

Select one, two or four tracks (with the Wave buttons) and set the song pointer to

the beginning of the part you wish to edit. Selecting "Wave Editor" from the Edit

menu will open a window and the data will be loaded into memory from disk.

The Wave-Editor-Window

The actual amount of data loaded depends upon the amount of free RAM and the

width of your screen. The sample display lets you monitor the audio data visually

(at least when it is first loaded) and therefore takes up most of the space in the

window. To the left is an area containing all the elements necessary to edit the

material i.e. buttons and popup menus.

9.2 The Sample Display

ZoomThe window elements of the wave editor include objects for horizontal and vertical

zooming (+/-). Using the left mousebutton the scaling will be decreased, using the

right button the scaling will be increased up to 1:1 (every pixel column represents

a single sample). the current scaling factor will be shown in the scrolling sliders.

Vertical zoom can be defined in a similar way - the quieter passages will be more

clearly visible if the display is stretched vertically.

The Wave Editor 9.1 Calling the Wave Editor
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Tile The display can be tiled according to the number of tracks in memory. Possible

values are one, two or four tracks simultaneously. Click with the left/right mouse

buttons to increase/decrease this value.

Scrolling There are two different forms of scrolling (see the picture):

Scroll the position of the display within the data already in memory.

Scroll the position within the song i.e. new data has to be loaded from disk.

The former is handled using the window elements (slider, arrows). Clicking on the

arrows will scroll in small steps, the grey parts of the slider box let you scroll in

steps of one "page" and the slider itself can be "grabbed" and moved directly to a

new position. The slider box will show you the position of the display in relation to

the song start in SMPTE-time resp. sample number. The vertical slider is used

analogeously to scroll through the tracks.

The second method of scrolling (in large steps, from disk) is accessed via the

arrow buttons under "Maximum Range" in the control panel to the left of the

window. The amount of data updated in memory depends upon the current

horizontal zoom - the next/previous part of the song will be loaded and a part of

the same size will be "lost" at the other end of the working area.

Note: If editor's data have been edited and not yet saved, the scroll arrows become

red resp. grey. Scrolling from disk will not automatically save these data, you may

have to save your work using the save function (see below).

Window menu There is actually a further method of positioning the display area within the

working area. Clicking on the "Window" button will open a popup menu where you

can choose between the following:

° Left margin (of the display) to the current song position

° Left margin to the left locator

° Right margin to the right locator

° Left margin to the start of the block (if one exists)

° Right margin to the end of the block

° If the chosen position is not within the working area the selection will be ignored.

° Call one of nine user-definable positions (including zoom and tile).

The position, zoom and tile values of the display area can be saved to one of nine

"window sets" by clicking on a set number while holding down the CONTROL key.

Used sets are marked with a dot. Previously stored sets can be called by simply

clicking on the appropriate set. Sets are saved automatically as part of the song

parameters and will thus be restored the next time the editor is opened. This does

not apply if, for instance, you have called the editor with a different number of

tracks or have reduced the amount of available memory. The data saved in sets are

pointers which are relative to the start of the working area.

9.2 The Sample Display The Wave Editor
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9.3 Range (Working Area)

The beginning and end of all sample data in memory are displayed as hourless

SMPTE times (mm:ss:ff) under "Maximum Range" in the control panel. These

values define the limits of the working area. The position within the song can be

scrolled using the arrows as described above or moved directly as follows:

° Clicking on the start time i.e. the upper of the two displays will open the song

pointer list - you can move the start to one of ten previously defined points in

the song (see the chapter "The Tape Transport Pad: Song Position").

° Do²³´µ ¶l·c¸i¹º »n ¼½e ¾i¿ÀlÁÂ lets you enteÃ the start tiÄe directly in ÅÆPÇÈ
ÉormatÊ

° Ë single click Ìhile holding down COÍTÎOL sets the editor to the current

song pointer.

These actions effectively close the editor and open it at another song position. This

means that the buffer (working area) is completely re-read from disk. If the option

"Keep/Undo Request" is active you will be warned in case data would be lost in the

process.

Current range = Current

wÏrking area

Ðhen mentioning Ñworking area" we haÒe meant the complete memory area which

has been allocated to the editor. "MaÓimum Range" has the same meaning.

HoweverÔ it is sometimes more convenient to limit actions to smaller sections of

the working area. Such sections will be called either "current range" or "current

working area", depending upon the context. Make sure that you understand these

terms as you may become confused if they are not clearÕ

Önder "Current Range" is a button×display which, when clicked on, opens a popup

menu containing the following listØ

° Maximum: This sets the current range to the complete working area and is

therefore the same as the "Maximum Range".

° Locators: The area between the left and right locators. This item is disabled if

one or both the locators are not within the working area.

° Window: That part of the working area which is currently visible in the display.

"Locators" is the default when the editor is first started (assuming that they are within

the working area).

The current range delimits the Keep/undo function, several block functions and

defines the start/end of an audio loop Ùsee belowÚ.

ÛÜÝ Þßàe áâãäåæ çè3 Raéêe (Working Area)
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9.4 Grid/Snap

The song pointer and

locators

The graphic display of audio data is well suited for precise positioning of the song

pointer and locators. The song pointer (the global one, not the editor's own audio

loop pointer) is set with a double click or CONTROL plus single click within the

position bar above the sample display. The locators are positioned by single clicks

on the left and right mouse buttons. The displayed time in the position bar

(mm:ss) are absolute i.e. relative to the start of the song and not to the beginning

of the working area. The exact position of the mouse pointer is displayed in the

mouse time box in the top lefthand corner of the window.

Grid The sample display can be overlayed by a time grid visible as vertical dashed lines.

Clicking on the "Grid" button will open a popup menu containing the grid units

second, frame, crotchet, quaver and semiquaver. If you have selected one of the

last three musical devisions, the time bar will show the number of bars and µbeats

instead of seconds and frames. In this case the grid popup will be expanded by the

entry "Options..." that leads you to an input panel. Use keyboard or mousebutton

to set sample offset, tempo (bpm) and time signature. The values will change in

smaller steps, if you keep the shift key pressed. The sample offset can be used to

adjust the grid to the audio data. If you change the tempo, the offset will be set

automatically, in order to place one of the grid lines to the beginning of the

current working area (e.g. the left locator). In this way it will be very easy to find

out the tempo of the area between the locators.

Snap The positions of songpointer and locators can be quantised to one of the devisions

described below. The snap grid has to be selected separately. Clicking on the

"Snap" button will open the same popup menu described above. The snap function

does not work when you input a position by number or recall from memory (refer

chapter 5.1 "The Tape Transport Pad").

Zero-Snap The wave editor also allows for so-called "zero snap" which acts on positions in

microscopic ranges of the wave and is independant of the above option. Zero snap

is also active when positioning the song pointer, locators and block markers. This

function looks for the best position for a smooth transition between parts - such

positions are (at best) samples of zero amplitude or (otherwise) samples of low

amplitude where zero is crossed (see the picture).

Such points can be seen clearly if you set horizontal zoom to maximum (1:1). The

samples will, in reality, seldom be exactly "0" - this only happens when a sample is

(by chance) taken at the right moment. A tolerance can be set (defined as a

percentage of the maximum amplitude) for this reason, below which the program

will consider the sample to be "favourable". The default tolerance is 0.5% - this

value has been found to be about right for recording via the ADC of a DAT

recorder to the SP/DIF. If you are recording using the Falcon's own ADC you

should change this value to 1.0%. Zero snap can be toggled on and off by clicking

on the button (depicting a wave) directly below the snap button. A double click

will open a small editable field in which you can type the tolerance directly.
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9.5 The Tooíbox

Clicking on the right mouse button within the sample display opens a small

toolbox (similar to those found in standard seîuencer programsï containing the

following toolsð

ñ. Standard mouse pointer: for positioning the song pointer and locators in the

position bar etc.

ò. Marker: for marking a block

3. Moóer: for copying or moving a block

ô. Eraser: for deleting single samples directly

5. Fader: for drawing a line which will increase or decrease amplitudes

6. Speaker: for playback a single track in the wave editor

A pencil will replace the speaker tool in the last four scaling factors.õith this tool

you may ödraw" samples÷ for instance, to close dropouts in the audio data. The

standard mouse pointer can be reverted to immediately by clicking on the display

with the right mouse button twice in succession.

øù6 úûüýiþÿ Samples

Although single samples can be edited directly, most of the edit functions are

block orientated. All edit functions can be called while a loop is being played back

- the results of an operation will become audible the next time around.

Er�sing sa�pl�sThe eraser tool can be used to delete one or more samples. Press the righ mouse

button to open the toolbox and select the "eraser" icon.

Zoom into the display and erase samples by holding down the left mouse button

while moving the mouse horizontally across the display. "Blips" and other

unwanted samples can be removed very quickly using this method.

Drawing samplesThe pencil tool can be used to "draw" samples. In this way clicks and noises that

result out of small gaps in the audio data can be closed.
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Changing �ynamics The dynamics of a musical passage can be edited using the "fader" tool. A

horizontal line amplifies or attenuates the signal linearly, whereas ascending or

descending lines will fade the samples in or out respectively.

Press the right mouse button to open the toolbox and select the "cross" icon. Click

on a point in a track where you want to start changing the dynamics - the vertical

position defines the starting level and should be above the central "zero amplitude"

line. Positions above a "neutral" line (half way up from zero) will amplify the

samples, positions below this will attenuate them.

Alter dynamics

A "rubber band" can then be drawn out to a second position (also above the zero

line) which defines the end of the section to be modified its

amplification/attenuation. The fader function can be aborted by clicking on the

right mouse button as long as this second point remains undefined.

The amplitudes of samples along the length of the line will then be modified by

interpolating the vertical positions of the fader line and multiplying each sample

with the appropriate factor. An alternative to this function are the "Fade In" and

"FadeOut" block functions described in the next section.

9.7 Block Edit

As already mentioned, most of the edit functions act on "blocks" - these are found

in the Block Edit menu. Click on the Block button and select the required

function. If a block has not yet been defined, all of the entries except "Create" and

possibly "Paste" will be disabled.

Marking blocks

A block defined via the Marker icon
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Blocks can be defined in two ways:

° Open the toolbox and select the Marker icon (vertical bar). Mark an area in

the sample display by holding down the left mouse button while sweeping

across the display. If you want the block to include several tracks you can move

the mouse pointer into other tracks before releasing the mouse button. The

marked area will be displayed in reverse. The limits of the block may be moved

automatically by the program if one of the snap options is active.

° Definition of a block including all samples within the current range can be

achieved by double-clicking the Marker icon or by selecting the "Create"

function from the Block Edit menu. This feature is very useful e.g. for defining

blocks limited by the locators quickly and precisely.

Rem�ving and changing

blockmarks

Block marks are cleared by clicking once inside the sample display using the

marker tool. The block marks can be changed via the block info dialog. You may

input start and end either in SMPTE time or sample position. Last one enables to

create blocks with an exact number of samples.

Fade InThe block will be faded in i.e. volume will increase from zero to the normal

volume.

Fade OutThe block will be faded out i.e. volume will decrease down to zero.

LevelThe volume of the whole block can also be modified linearly. Clicking on the

"Level" button in the Block Edit menu will cause a fader to appear within the

display which can then be moved vertically. Releasing the left mouse button will

cause the program to process the block accordingly - the right mouse button

aborts the function.

NormalizeAnother very practical function is "Normalize", which is similar to the "Level"

function described above. Normalize should be used sparingly for accentuating

particularly important parts of the music (e.g. a drum roll or a bell) because it

amplifies the block to the maximum possible volume.

ReverseThe reverse fuction gives you the ability to make an reverse effect.

PitchThe pitch function enables the tuning of a block about+/- 10 % in a resolution of

120 steps. 10 % corresponds nearly to the interval of one entire tone. Good results

can be expected if a relatively short block is edited. In the same way as editing

block level, the tuning can be controlled by a fader also while audio loop runs.

Quit function by clicking outside of the control panel (left button means "OK",

right buttons means "CANCEL").

CleanThis function tries to remove "clicks" and "blips" and smoothes hard cuts between

the block limits.

ClearClears all samples from the block.

DeleteDeletes the entire block. All data within the working area (sic) which follows will

be moved to fill the space. Caution: this function can cause the timing of the

track(s) to be shifted against each other (see the picture), so you should decide

very carefully on the tracks and the area when you define the block! The block

marks will remain after the operation but will of course now contain data which

has moved to fill the space.
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The current working area is "Locators" in the picture. The data which is moved is

displayed grey for the sake of clarity.

Insert This function is the opposite of "Delete". All sample data from the start of the

block to the end of the working area will be moved the length of the block "to the

right". A space will thus be created whose length is the same as the block.

Note that "Insert", like "Delete" can cause timing problems if the block is not

defined carefully. Another problem is that the last part of the working area is lost

(see picture).

The block marks will remain after the operation but will contain no data.

The "Insert" function. Note that data from the end of the working area ("Locators"

in this example) is lost in the process.

Copy to L This function is used to copy the contents of a block to the position of the left

locator (if the latter is within the maximum working area). The block will be

copied to the first track(s) which are visible (sic) in the active display - the

required destination track(s) can be set using the tile function and the vertical

scroller. Note that "Copy to L" also moves the block markers to the new position.

This funktion moves the whole block including the marks!

Move to L Similar to "Copy to L", but the block will be moved to the new position i.e the

original block will be cleared. ".

Clip A block can be copied to the clipboard for later insertion. There is only a single

clipboard - any data already in the clipboard will be overwritten whenever "Clip" is

called (cf. "The Structure Menu: Clip Part"). The block (or better - the "object")

can be pasted either as a block using the "Paste" function (see below) or as a "Part"

using the "Paste Part" function from the Structure menu.

Paste If there is an object in the clipboard it can be pasted into the Editor. It doesn't

matter whether the object was originally a Part or a Block (cf. "The Structure

Menu: Clip Part / Paste Part"). The object will be copied to the position of the left

locator if this is within the working area (maximum range) and will appear there as

a block. The destination tracks are set as described above ("Copy to L"). If the

whole object will not fit (horizontally or vertically) into the working area you will

be warned via an alert box - if you are not willing to copy only part of the object

you have the chance to abort the function with "Cancel".

Magnify Magnify will zoom a block to the highest possible size. You can use also the tab

key to select magnify. If you want to restore the old view just select shift + tab.
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Moving or copying a blockA block can be moved or copied graphically using the Mover tool:

Open the toolbox by clicking in the display with the right mouse button and select

the Mover icon (four arrows). Click within the block: a ghost copy of the wave will

appear. This can then be moved to any position within the maximum working area.

Moving to the edge of the display will scroll in that direction.

Click with the left mouse button to position the block; if you hold down the

CONTROL key at the same time, the data will be copied instead of moved. As

usual the action can be aborted with the right mouse button.

Switch to overdub mode with the ALTERNATE key an move the block or copy

the block with ALT+CTRL.

Undo/RedoUse the Undo function (UNDO key) to undo/redo the last change in the wave

editor without leaving the editor window.This function is only available if you have

activated the option "Reserve UNDO Buffer" in the "Memory Configuration"

dialog.

9.8 Data Transfer with the Hard Disk

SaveYou can save the current working area to the song at any time. Only those tracks

which are visible in the display will be saved.

If the current range is "Window" the function will save only the data which is

visible in the display. Parts of one or more tracks can be saved by setting the left

and right locators accordingly, setting current range to "locators" and displaying

the correct tracks via "Tile" and the vertical scroller.

Click on the Save button. If the Save/Load Request option (Options menu) is

switched on you will be warned first.

Load"Load" is often used to discard changes. Unlike "Last Version" functions found in

other programs, only the current working area will be updated from disk. Whether

the original (before calling the editor) data from memory or data from disk will be

loaded depends upon your way of working.

9.9 Audio Loops

PlayThe current range can be played back as a loop. Almost all the editor functions

can be called during playback so you can monitor your work. The locators can also

be repositioned during playback - this will take effect the next time around.

Playback is started with the Play button within the editor. The loop will be stopped

as soon as you click on the Stop button or close the editor. You can switch back

and forth between Cycle mode (tape) and Loop (editor) to compare your edited

version with the original.
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Record There is an alternative to recording in cycle mode. A record loop can run within

the editor window, the advantage being that this method is non-destructive i.e will

not be written automatically to the hard disk. You can also see what you record -

the graph will be updated after each cycle. Firstly, select tracks to record on by

clicking on the record button to the left of the zero snap button and then select the

track from the popup list. Tracks selected in the popup will be marked with a dot.

The input mode (STEREO/MONO) as set in the Audio Parameters window is

valid for the recording.

A loop within the current range can then be recorded to. This would usually be the

area between the left and right locators because they can be set independantly to

define a musically sensible loop.

Click on the record button at the bottom of the editor window to start recording.

The record area will become red (or inverted in b/w) and you can start playing the

instrument.

This method of recording is always in cycle/overdub mode (cf. "Further Record

and Playback Functions").

9.10 Closing the Editor

It should be clear that you can call other functions outside of the editor or bring

other windows into the foreground at any time. However, the memory allocated to

the editor is not freed until the editor is closed so that some functions may not

have enough memory to operate. If you consider your work (within the editor) to

be finished it is best to close the editor first before attempting to call other

functions.

Close the editor with "Keep-Close" if you want to update your song on the hard

disk. The working area is always saved. If you only want to save the current

working area you should select "Save" first and quit the editor via "Cancel-Close".

Quitting with "Cancel-Close" means that any work you have done in the editor will

be lost unless you "Save" first.
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The Menus

10.1 The Structure Menu

Song Overview

The first menu entry will open a window, that displays all sections of each track

containing something else than "silence" (i.e. data on disk not equal to zero) as

coloured bar graphics. Left hand you will find buttons to select tracks for

playback, recording or using in the wave editor. These buttons are switched equal

to the buttons of the mixer. In a similar way to the wave editor you may place

songpointer and locators by clicking inside of the time bar. If the overview-window

is the top window the songpointer will be displayed during playback or recording.

The window is supplied by elements for sizing (fullbox, sizebox), iconifying (refer

6.1 Window Handling), scrolling and scaling in horizontal direction.

Before window can be opened for the first time - especially if it's a song made by

an earlier program version - song data have to be scanned from the beginning to

the end. This operation will be accompanied by a progress bar and can be

interrupted by clicking the right mousebutton. The overview data will be saved

automatically when you quit song or program.

Functions that work on audio data (structure functions, recording, importing data,

etc.) will cause a rescan of the changed µsections. If the overview window is not

the top window, this scanning will be done later. You may also cause a rescan by

clicking on the "Rescan" button.

Song StructureThe structure of the current song, i.e. length and number of tracks can be changed

by the dialog "Song Structure" described in chapter 4.2.

Most of the following functions require a source and a destination. The tracks

which are to be manipulated are selected by activating either the Play or the

Record buttons in the mixer, depending upon the function called. As processing

the data can take a while, progress is displayed as a horizontal bar.

Note: All structure functions work on the harddisk data, so they cannot be undone!

If you are not sure you can make file copies using the export function.

Track operationsCopy Track

This copies a track (selected with "Play") to another (selected with "Record").

Even if more than one track is selected, only the first will be copied (to). The

complete track will always be copied i.e. the locator positions are ignored.
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Swap Tracks

Swaps two tracks (both selected with "Play"). Only the audio data will be swapped

- mixer settings are retained.

Clear Tracks

Clears all tracks selected with "Play". The whole song can be cleared by selecting

all tracks and calling this function.

If you only work with snippets of music e.g. to form musical "collages" and there

are bits of old recordings on the disk (which would usually be the case) you should

"clean up" the track before starting work on a new song. "Clear Tracks" is not

called automatically e.g. when a new song is created because the function can take

a while (depending upon the number and length of the tracks) and it would be

unnecessary for tracks which are going to be completely overwritten.

Part operations Delete Part

Cuts out the part (section of "multitrack tape") between the two locators and

discards it. Do not confuse this function with the "Clear Part" function described

below. Unlike cutting a real-world tape, "Delete Part" only cuts out from particular

tracks (selected with "Play"). Remember that this can cause tracks to be shifted in

time against each other if not all the tracks are selected! This feature can be used

to shift tracks which have been recorded out of sync.

The following "trick" can be used to get around a disadvantage of the system (that

only two tracks can be recorded at once). You want to record a live performance

where you need four separate tracks (e.g. stereo drums, guitar and bass or four

acapella singers) so that they can be mixed afterwards; you also have access to two

DAT recorders. Record the performance using the two decks. Copy (digitally) both

recordings to your hard disk and, using the "count-in", synchronize all tracks using

"Delete Part" (see illustration).

Independantly recorded tracks can be synchronized (using the "count-in") via

"Delete Part".

Insert Part

This function is the opposite of "Delete Part". An empty part whose length is the

same as the difference between the left and right locators is inserted at the

position of the left locator. Tracks selected via "Play" will be moved to the right -

all other tracks are not affected.

Note: The total length of the song will not be changed here: data shifted "beyond" the

end of the song will be lost!
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Clear Part

Clears selected tracks (with "Play") between the left and right locators only. Not to

be confused with "Delete Part".

Repeat Part

This function is used for creating a row of repeats of the selected part. A dialog

box is opened in which you can set the number of repeats. All tracks selected (with

"Play") will be included in the operation. Copies are not inserted but will overwrite

subsequent data. The song cannot be lengthened using this function - the

maximum number of possible repeats is therefore limited by the length of the

song.

Copy Part

The marked part will be copyed to the current song position only. Just the selected

playtracks will be affected.

Clip Part

This is similar to "Copy Part" except that the destination is a clipboard. The

clipboard is not in RAM but is part of the partition you have declared as "tape" so

you should take care to leave some space on the "tape" when creating a new song

(otherwise you will not be able to use the clipboard!). The clipboard can be used

to transfer data to or from the Wave Editor or another song on the same "tape".

Remember that the clipboard can only hold a single object - previous data in the

clipboard is replaced as soon as "Clip Part" is called.

empty Clipboard used Clipboard

Clicking on this icon will inform you about the number of tracks and the size of the

object in the clipboard.

Paste Part

Retrieves an object from the clipboard and copies it to the current position of

either the song pointer or the left locator. The "object" can either be a Part sent to

the clipboard with "Clip Part" or a block from the Wave Editor (cf. Clip/Paste

function in the chapter "The Wave Editor"). The destination tracks are selected

with their "Play" buttons. Note the following when copying from the clipboard:

The data is not "inserted" but will overwrite any data in that position. To insert you

should make enough space to accomodate the Part first ("Insert Part"). The length

of the object (and therefore the extra space you will need) can be determined by

clicking on the clipboard icon.
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Make sure that the correct destination tracks are selected. If the clipboard

contains data from more tracks than the number of selected tracks or there is not

enough room left in the song you will be warned with an alert box. Click on "CUT"

to accept loss of the overhanging data or "CANCEL" to abort the action.

The object is copied, not moved i.e. it will also remain in the clipboard and can

thus be pasted as often as you wish (until it is overwritten with "Clip Part" of

course).

Part �nfo The part info box shows infos about lenght and activated tracks and can set new

values for locator positions.

10�2 ��� Edi� Menu

Wave Editor This opens the Wave Editor. If the editor window is already open (the entry is

ticked) it will be brought to the foreground.

All editor functions are described in the chapter "The Wave Editor".

Effect Windows If you have selected an effect type (Reverb,Gate or EQ via the Audio Parameters

window) a window will open in which the global effect parameters can be set.

Audio Tracker lets you configure the effect parameters:

Reverb ° Reverb Gain: Output level of the "wet" signal.

° Early Reflection: Output level of early reflections.

° Decay Time: Length of reverb until it finally disappears.

° Delay Gain: Output level of echos.

° High Frequency Attenuation: 25%, 50% and 75%

Play back the recording and experiment a while with these parameters (the editor

window must be in the foreground). You should find it more difficult to create

natural reverb than synthetic-sounding effects.

On the right of the window are seven memory buttons - the first four already

contain editable "presets". Selected buttons will be deselected as soon as you edit

the effect. Custom effects are saved to one of the memories by clicking on it while

holding down the CONTROL key. The memory button can be given a new name

by double clicking on it and entering the name in the editable field.
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D��l 9-Ba�d EQ���� th� EQ t�� ��dio t�a��� ca� be controlled inde endently" First select the

position of the EQ: Pre#i$ or Postmix.

%n Premix mode you can select two of the audio tracks for processin&. In Postmix

mode the complete stereo-mix signal will be processed. 'he Postmix mode is not

a)ailable in Channel mode.

*ove the ten gain faders with the left mouse button. With the right mouse button

the secon channel will be affected, too. Reset all faders with the 2Zero' button on

the left hand side.

All settings will be displayed on the mixer page. The red LED's indicates the

active EQ channels.

Ga45The main task of a 6gate" is to reduce noises but it can be used also to create

special sound effects 7e.g. hard attack drums using a high "threshold" and a short

"decay"8.

° Threshold (- ... -9: d;) This is the level that has to be exceeded to open the

gate (i.e. to let the signal pass). A threshold of - dB is equal to switch off the

gate because in this case the gate is always open. <ou may select different

thresholds for each track. This parameter can also be edited in the mixer

window but not in the same fine resolution.

° Gate on/off The buttons below the threshold faders resp. the button "GATE"

in the mixer window switches the gate on/off.

° Range (- ... 0 dB) This parameter determines the grade of level reducing if gate

is active. A value of -=0 dB reduces all signals under threshold about 40 dB.

Absolute silence will be created by selecting "- dB"; "0 dB" is equal to switch off

the gate.

° Attack (0...>66 ms) This parameter determines the speed of gate opening when

the level of the audio signal exceeds the threshold value.

° Hold (0...666 ms) This parameter determines the time, that the gate will stay

open when the level of signal comes under the threshold value.

° Decay (0...9999 ms) This parameter determines the speed of gate closing when

the hold time is over. If the signal exceeds threshold during the decay time, the

gate will be opened again (in the speed of "attack").

° Premix / Postmix The gate can be switched before or after the level faders

("premix" manipulates the original signal). In the stereo output mode the gate

works on the stereo sum, if you have selected "postmix". In this mode the effect

editor offers only two threshold faders for the left and right output channel.

Offl?ne Effe@tThe current effect can be processed "offline", i.e. the audio data on the harddisk

will be changed. In this way you are able to use more than one effect in one song

or to remove noises in your recording.

Gtart playback and edit the parameters using the effect editor. Stop playback. The

range of the function can be limited using the locators.
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Call "Offline Effect". A dialog will be opened to select the concerning tracks and

the desired range ("Song" or "Part"). Quit dialog clicking on "OK" to start the

processing.

Note: The effect processing will not be influenced by the setting of the level

faders, so the pre/post selection has no effect. Since this is a "destructive" function

it may be better to make a safety copy using clipboard or export function.

Convert Sample Rate The sample rate of a song can be converted using this function. You have a choice

of ten of the better-known frequencies between 18900 Hz (CD ROM) and 49170

Hz (Falcon). The current frequency can (at most) be doubled or halved, so some

of the entries might be disabled.

Audio Tracker distinguishes between playback frequency and "real" frequency

because any arbitrary playback frequency can be chosen in the Audio Parameters

window. The real frequency cannot be changed directly - it is determined at

record-time or by conversion (see below). Clicking on the title bar of the mixer

window gives you information including the real frequency of the song. The

"Current Freq." in the Convert Sample Rate dialog box is the same value.

Some of the listed destination frequencies are not supported by AudioTracker i.e.

these frequencies cannot be played back within the program. They are included

for compatability e.g. for exporting data to Mac or PC.

When sample frequencies are converted the amount of data, and therefore the

size of the song on the hard disk, is changed. If the option "Adjust Tape Structure"

is switched on, all the following songs are moved i.e. copied to new positions - this

can take a while but is the only way to prevent data from being lost or wasting

space on the hard disk. If the option is not activated, conversion to a higher

frequency would cause data at the end of the song to be lost, conversion to a lower

frequency would leave unused space at the end of the song. The difference

between the lengths of the original song and the converted one can be calculated

using this simple formula:

Difference = song length - (song length * new frequency / old frequency)

Converting between 44.1 Hz and 48.0 Hz will change the song length by about 8%.

When the amount of wasted space at the end of the song is not much, it may not be

absolutely necessary to switch "Adapt Song Structure" on.

If there is not enough free memory on the disk to allow "Adapt Song Structure" an

alert box lets you abort the action via "CANCEL". Clicking on "CONTINUE"

causes the song to be converted without the length being adapted!

° Conversion is "destructive" and therefore cannot be undone! Conversion back to

the original frequency will always result in loss of quality.

° The quality of a recording which has been converted to a higher frequency is

always lower than if the material had originally been recorded at this frequency.
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10.3 The Options Menu

AudiJ PaNameterQThis menu entry has been mentioned quite often in the manual - it opens the

"Audio Parameters" window. If a song is already open the current song parameters

are adapted and will be saved automatically. If you have not opened a song, the

parameters will be based on those used when creating a new song with the

function "New Song" (File menu). You should at least enter the required sample

frequency so that the correct amount of disk space required by the song can be

calculated by the program.

All the audio paramters are explained in the chapter "Installation and Program

Start: Software Adaptation".

XZnchronizationSelecting this entry opens the synchroni[ation dialog box. This is described fully in

the chapter "Synchronization".

Sna\Used for selecting the snap mode from a popup list. Snap will only affect locator

positions during playback if it is used outside of the Wave Editor (see the chapter

"The Tape Transport Pad": Left and Right Locators". Snap options are described

in the chapter "The Wave Editor: Snap".

PrerollSelecting the preroll button will switch on and off the preroll function. The preroll

function is also valid in the punch in mode.

Structure RequestAll the structural operations in the Structure menu are destructive i.e. they cannot

be undone, and that is why an alert box opens every time you call one of these

functions. Experts can switch off this feature, but we recommend that you leave it

on (ticked) so that, for instance, hitting the DELETE key by mistake doesn't

destroy two day's hard work by deleting a part without warning!

Memory ]onfi^urationThis menu item opens a dialog for setting up the memory configuration for the

wave editor. If editor is opened already this item will be disabled. The first two

lines in the dialog show the free memory space, separated into ST-RAM (the

original Falcon RAM) and - if available - TT-RAM (alternate RAM). If the

alternate RAM should be used as edit memory you have to select the option "Use

Alternate RAM". Since the audio functions of the editor play data ´directly from

the edit memory, you may care that the alternate RAM is able to do this,

otherwise you will hear nothing. The undo function of the editor can only be used

if you have selected the option "Reserve UNDO buffer". The undo buffer needs

the same size of memory than the editor but prefers alternate RAM if available.

Normaly, the editor tries to allocate all of the free memory to get a large working

area. If this is not desired, you may input the number of bytes the editor has to

leave. Less memory space for the editor shortens loading times and may avoid

memory deficiency using block or file functions. We recommend to treat a

minimum about 20000 to 50000 bytes in any case.

Sho_ SMP`E / Show

Samples

If the mouse is inside the sample display, it's position is displayed either as

SMPTE time or as sample number. This menu item switches between the two

possibilities.

The Menus 10.3 The Options Menu
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Save/Load Request The functions "Save/Load" and "Keep/Undo" are used for data transfer to and

from the hard disk by the Wave Editor. There would normally be an alert to warn

you that data may be lost in the process - this feature can be switched off (no tick).

Quick Screen The level indicator and the songpointer display are drawed by certain graphic

subroutines to enable a quick refresh also during the harddisk accesses. These

subroutines do not work together with some graphic accelerators. In this case you

have to switch off this option.

Level indicator Use this button if you have problems with performance. The peakmeters will not

be redrawed.

Colors If the program runs in color mode, you can set the colors of the wave editor's

display, the overview's bar graphics and the desktop background to your

preferences. Instead of the uni-colored desktop, you may load any GEM image

(*.IMG) in size of 64 x 64 or 128 x 128 pixels with number of colors not higher than

current graphic mode.

10.3 The Options Menu The Menus
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Synchronization

AudioTracker supports several methods of synchronizing the program with MIDI

recording equipment and/or other hardware (a hard disk recording system based

on AudioTracker can have 16 tracks or more).

Although connections in all the modes are via MIDI, only synchronization with

sequencers or MIDI recording systems will be called "MIDI Synchronization" - if a

second Falcon (and AudioTracker software) is added to the system this is via

"Audio Synchronization".

Open the synchronization dialog (Options menu) to select the appropriate mode.

AudioTracker will be either the "master" or the "slave" in all modes.

11.1 AudioTracker as Master

AudioTracker should generally be used as master when synchronizing together

with MIDI recording systems because any tempo problems the sequencer might

have cannot be corrected by the program.

Send MIDI Time CodeAudioTracker sends MIDI Time Code (MTC) in this mode. Set the appropriate

synchronization parameter of your MIDI system to "receive" ("external SMPTE",

"ext. MTC" or similar). The MIDI system will then start at the correct position

when you run AudioTracker and will carry on synchronously because the song

position is transferred in SMPTE format.

Send MIDI ClockThis mode should only be used as a last resort if your MIDI system does not

support MTC. There are two main reasons for avoiding this mode: Firstly, MIDI

Clock is not precise enough for many applications. Secondly it is not a true time

code but is dependant upon tempo (hence the name) i.e. AudioTracker

determines the tempo of the MIDI system. Set the required tempo in

AudioTracker via the keyboard or by clicking on the arrows.

Send MIDI-Song-PointerThis option should be switched on (inverted) if you are forced (or wish) to

synchronize via MIDI Clock. This causes the song position to be updated in the

slave system (i.e. MIDI system) - otherwise only start and stop signals would be

sent and the song would have to be started from the beginning each time you run

it. It is also a nice feature together with MTC as you can follow the song position

in the MIDI system while rewinding etc.

Send AUDIO CodeAudioTracker also implements its own system exclusive "Audio Format" for

running more than one Falcon simultaneously (both computers must be running

AudioTracker). A dedicated format was necessary because the program has to

run several initialization routines before record or playback - there is a delay

between activating the Start button and playback which can vary according to

several factors. To the right of the "Synchronization" dialog box is a box marked

"Delay": increasing this value will cause two Falcons to be synchronized more

safely (i.e. they will both have enough time to carry out the above mentioned

initialization routines). The default value of one second can usually be reduced

without problems arising. The current version of the Audio Format includes

Start-Play, Start-Record, Stop and a precise Song pointer (to single samples).

However, the system is being developed further and future versions will also

include locator positions, song selection, sample frequency etc. Practically, this

means that the present version allows remote control of "tape" transport for both

Synchronization 11.1 AudioTracker as Master
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systems from the master system. If you wish to record on the master and play back

from the slave then you should start the slave first (Play) and then the master

(Record).

Tempo The value of "Tempo" controls the speed of the sequencer if MIDI Clock is used.

It also affects the musical "snap" quantisation. It therefore makes sense to enter

the tempo here even if synchronization is via MTC. This value is otherwise of no

importance, but can be helpful for the Wave Editor or while setting locators.

11.2 AudioTracker as Slave

Receive MIDI Time Code AudioTracker cannot compensate for tempo fluctuations if it is running as slave.

This mode is therefore only used as a trigger so that AudioTracker starts as soon

as MTC is received. This function was implemented at the request of several

users who wanted to synchronize AudioTracker with analog tape machines e.g. to

"fly" single short passages from tape into an AudioTracker recording.

AudioTracker is ready to receive MTC whenever record or playback is activated

at any position in the song. Reception can be interrupted by clicking on the right

mouse button.

More time is required when the song is to be started at the beginning due to the

above-mentioned initialization routines and calculation of the correct sample

position. The program can only be started with a short delay. The editable delay

value makes this effect calculable so that synchronous start is possible - do not set

this value too low!

If, for instance, you want a recording or playback to start at the song position

00:01:00:00 you should start the tape machine at 00:00:59:00, assuming a delay of

1.0s. AudioTracker will initialize, wait and start at exactly 00:01:00:00 even if the

initialization is finished before this time.

Receive AUDIO Code This mode only works when the system is connected to a second Falcon with the

"Send AUDIO Code" option switched on. As soon as e.g. the "Play" button is

activated on the master, the slave will receive a signal for an imminent playback.

Unlike MTC you don't have to switch AudioTracker into stand-by yourself. The

program initializes playback and waits for the final start signal from the master.

Only when this is received will the "tape" start rolling. The slave therefore needs

two signals. The delay is set on the master and is not important for the slave. The

slave can be forced into the above-mentioned "wait" state by simply clicking on its

"Play" button (in our example). The master's first signal would then be ignored.

This feature allows recording on the master and playback on the slave (or vice

versa).

11.2 AudioTracker as Slave Synchronization
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11.3 Installation

This section illustrates three example applications. The synchronization settings

required and any changes to be made to the MIDI system are listed below each

diagram. The MIDI system of the first example consists of an Atari ST running

MIDI recording software (e.g. Cubase, Notator or similar), a MIDI keyboard (e.g.

a master keyboard) and a sound source (e.g. an expander module).

MIDI-Synchronisation

j{|}~������r ��a��er� M��I���ste� (S�a�e)

a) se�d MIDI Time �ode ��tern SM�TE-Sync�

o�tional� �eceive MTC

Send MIDI-Son�pointer Set tempo

�R

�) Send MIDI Clock External MIDI-Clock-Sync

Send MIDI-Song Pointer Set tempo, i� t�is exists

Set tempo Activate tempo correction

(e g. in Cubase: s¡itch Mastertrack on)

Ex¢£as: A MIDI Merger is re¤uired for the above configuration so that both the

master keyboard and the ¥alcon can be connected to the ST's ¦MIDI In" port.

If you want to avoid buying extra harware you can modify a standard MIDI cable.

The Falcon's MIDI OUT socket also has a MIDI T§RU signal! If you have any

experience at all with a soldering iron, this shouldn't be too much of a problem.

Open the plug at one end of the MIDI cable and connect pin ¨ to pin © and pin 3

to pin ª. Pins 1 and 3 are not normally used by MIDI, which means that the cable

can be used later for standard connections. You can now connect all the

components in series:

A standard MIDI cable can be modified to make use of the Falcon's MIDI THRU

signal.

«¬­®¯°±n²³µ¶ion ·1¸3 In¹tallation
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Audio synchronisation AudioTracker 2 (Slave)

Receive AUDIO Code Delay at least 0.5 s

AudioTracker 1 (Master)

Send AUDIO Code

Both AUDIO and MIDI AudioTracker 1 (Master) AudioTracker 2 (Slave)

a) Send MIDI-Time Code Receive AUDIO Code

optional:

Send MIDI-Song Pointer

Send AUDIO Code MIDI-System

Delay at least 0.5 s Extern SMPTE-Sync,

Receive MTC , set Tempo

OR

b) Send MIDI Clock Extern MIDI-Clock-Sync

Send MIDI-Song Pointer set tempo, if

Send AUDIO Code this exists,

Tempo einstellen Activate tempo correction

Delay mindestens 0.5 s (e.g. in Cubase: switch Mastertrack on)

Note: The selected synchronization mode is only active if the SYNC button in the

tape transport pad is switched on!

MIDI Remote Level, Panorama, Masterfader and Play/Mute can be remote controlled by MIDI

events. In order to do this you can set different controller values for each value.

If mixer window is not active, i.e. is not the top window, MIDI data will be

received and processed, but faders will be redrawed when mixer comes to

foreground.

11.3 Installation Synchronization
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Data backup, import and export

12.1 Streamer Function

The streamer function can only be used if there is a DAT recorder connected to

the Falcon via an S/PDIF interface. You should reduce the volume of the

connected amplifier because data transfer is not very musical to say the least! It is

also very loud. Select "Back Up Tape" from the File menu. Select the partition to

be backed up in the dialog box. The streamer function is specially tailored for the

AudioTracker data format and can only handle files which have been declared to

be "tape". Make sure that a start-ID is set on the recorder as you might need to

find this data later! The ID can be automized (AUTO) by most DAT recorders,

but if there is a longer pause other IDs might also be set (these can safely be

deleted). Start recording on the DAT machine. As soon as the tape is running,

click on "START!" in the dialog box. The familiar progress-bar will let you know

how much data is still to be saved. The partition and the name of the tape (if

named) are also displayed.

The display disappears as soon as the bar reaches the end. You can stop the DAT

tape and set an end-ID.

If you want to make sure that the DAT machine has recorded all the data

correctly you can verify it as follows: Rewind the DAT tape to the start-ID and

click on "YES" in the alert. Press the playback button on the DAT recorder.

AudioTracker will now compare all the recorded data with data on your hard disk

and you will be informed if any errors i.e. differences are found. Faulty backups

should be repeated - you may have to change the DAT cassette for a higher

quality one.

The backup process can be interrupted at any time by pressing the right mouse

button; however, then is no guarantee that the backup data can be restored

correctly.

12.2 Restore Tape

This function writes a partition which has been saved with "Back Up Tape" back to

the hard disk. The partition does not have to be the same one which was saved, but

must have at least the same capacity. The destination partition must also be a

"tape" so that AudioTracker can recognize its position and size and thus adapt the

transferred data to it. This function is operated in a similar way to the backup

function: Select "Restore Tape" from the File menu and choose a destination

partition in the dialog. Wind the DAT tape to the required position. Click on

"START!" in the dialog box and play back the DAT tape. The name of the tape

and the destination drive will be displayed as soon as the program has recognized

the tape data and if the destination partition is large enough - the data is restored.

If you have selected the wrong partition by accident you can abort the action by

pressing the right mouse button. This is only a "last resort" - if any data has already

been transferred you will have overwritten data on another "tape", assuming this

"tape" is not empty. However, the directory (which describes all the songs on the

"tape") is only updated after all the data has been restored without any errors, so

the damage is minimized. All this should make it clear that this function cannot be

used to restore only part of the data on tape:

Data backup, import and export 12.1 Streamer Function
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Note: The streamer functions work with "images" - they are not conceived for saving

or restoring anything but complete "tapes". In an emergency i.e. if for some reason the

data on a DAT tape is incomplete, transfer should only be interrupted by hitting the

PAUSE key on the DAT recorder. The restore function itself must be allowed to

finish normally otherwise the restored data will not be accessible ("Open Song" will

not work).

Saving a single song (or parts of a song) can be achieved using the export function

described below.

12.3 Audio Import

Sample files in AVR-WAV-DVSM- or AIFF format can be imported into your

song. The data can be loaded directly to hard disk or into the Wave Editor. In

both cases, a destination position must be defined first. This position is defined by

the left locator when importing to hard disk (i.e. directly into the song) and the

destination track is selected with the "Record" button in the mixer window. If you

are importing into the Wave Editor, the current working area defines the

destination. To import the samples to the position of the left locator set "Current

Range" to "Locators". The destinatio track is the track selected from the Wave

Editor's "Record" popup list (cf. the chapter "The Wave Editor: Audio Loops").

Call "Audio Import" and select the required file from the standard file selector.

The program opens a dialog box displaying the sample format, size in kilobytes

and the length as SMPTE time (at the current sample rate of the song).

If you want only a part of the file to be loaded, you may input start and end of this

section as SMPTE time.

Below this are two editable fields containing assumed destination parameters.

Check the information carefully, especially the track numbers - if the sample file's

format (mono or stereo) does not match the record mode, AudioTracker would

record to the next track (stereo mode) or only to the first of two selected tracks

(mono mode).

The Audio Import Dialog Box

If the Wave Editor is open the program assumes that this is the destination for the

sample data and the corresponding field is preselected.Click on the field with the

destination you want .If the destination area is unable to take up data completely,

you will get a message with the opportunitiy to exit.

12.3 Audio Import Data backup, import and export
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The import function can be used to copy data from audio CD directly into the

wave editor or onto the harddisk. A CD ROM drive that supports audio functions

is required. In the fileselector you only have to select the drive instead of a

filename - a further menu appears if an audio or mixmode CD is inserted. After

selecting the desired CD track, the import dialog will be opened and import will

be continued as described above.

Note: Not all of the CD-ROM-drives supply audio data with a reliability of 100%!

An error check tries to locate them, but it may happen that the function must be

finished ("Audio CD Read Error!" will occur). A retry may be successful all the

same! The progress bar message box shows you the number of data errors, so that

you can decide to interrupt or not. Since not all errors can be found, it is

recommendable to check the data by ear or using the zoom function of the wave

editor.

º»¼4 A½¾¿À EÁÂoÃÄ

ÅÆÇÈÉ ÊË tÌÍ soÎÏ Ðan Ñe saÒeÓ as a saÔÕÖe f×le in different formats so that the data

canØ for instance, be edited Ùith another programÚ Ûhe soÜrce is defined as either

a Part Ýbetween the locatorsÞ or a blocß in the àave áditor. âf ãou want to eäport

a Part you should select the reåuired tracks with their æPlay" buttons ç you can

export any arbitrary tracks, they don't have to be neighbours. èalling the "éudio

Export" function will open a dialog box in which you can set the followingê

° ëormat: Choose AVì,WAV,íVîï or AIFF and MðNO or STEREO

° Source: If the Wave Editor is open and a block is marked you have a choice

between "Tape: Part" and "Wave-Editor: ñlock". Check the entries for the

start position and the tracks because only the first source track (mono) or the

first two (stereo) will be exported.

The Audio Export dialog box

All actions within the dialog are interactive i.e. all variable parameters will be

updated immediately. If you change (for instance) from MONO to STEREO, the

siòe in KM will double and an extra track will appear in the source fields. If you

select a different source the length (SMPTE time) will change accordinglyó the

mode might also be switched automatically to MONO and the STEREO button

will be disabled if the new source only contains a single track. The choice of

format depends upon the program which you want to load the data into - most

programs can read AVR format. The well-known programs "Logic Audio" and

"Cubase Audio" can load AIFF and "Audio Master" is happy with either format.

Click on [OK] when you are satisfied with the settings. A file selector is opened

with which you can choose the path and file name. AudioTracker checks first

ôõta öa÷øupù iúport aûd üxport 12.4 Audio Export
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whether there is enough space available on the destination medium and gives you

the chance to select a different destination if the first one is too small.

The export function can be used to "stream" a song or individual tracks to DAT.

The procedure is as follows: Set the left locator to the beginning of the song and

the right locator to the end. The simplest method is to wind to the end of the song

using fast forward and then click on the display of the right locator while holding

down the CONTROL key. You can then export pairs of tracks in stereo. Stream

the files with the program "DataDat" which is part of the S/PDIF package. The

files can then be loaded back into AudioTracker at any time in the future without

causing synchronization problems between the tracks (they all have definite

positions).

12.5 Cubase Import

This function can transfer a complete cubase audio arrangement to an

AudioTracker tape file. In order to do that just select all parts in cubase with

ctrl-a and save it as "*.PRT". Also save the audio pool ("*.POL"). In AudioTracker

select this two files and after that you can make an individual channel routing to

AudioTracker tracks.

The flag skip muted tracks/parts will skip muted tracks/parts.

12.5 Cubase Import Data backup, import and export
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Basic Principles

In order to be able to process audio signals with a digital system like a computer,

the voltage of the signal must be sampled (i.e. measured) at very short regular

intervals and these values stored as a list of data. This is the job of the ADC

(Analog to Digital Converter). The data can be converted back to audio signals

using a DAC (Digital to Analog Converter).

Sample RateThe quality of the results depends to a large extent on the "sample rate". The

sample rate (also called "sample frequency") is the number of times per second

that the voltage is sampled. The rule of thumb is: the higher the rate, the better the

quality. As you need at least two values to describe a wave (think about it!), the

sample frequency must be at least double the frequency of the highest frequency

in the source. The human ear can detect frequencies up to around 16 kHz (some

say 20 kHz) and so a sample rate of 32 kHz is high enough for many purposes.

This means 32000 samples per second, per channel!

A few sample rates have become de facto "standard" e.g. 44.1 kHz (CD) and 48.0

kHz (DAT). Some applications also work with 32 kHz e.g. digital radio and

long-play DAT.

Most digital audio equipment, including the Falcon, work with 16-bit resolution -

the "measurements" are much more precise than 8-bit. Signals with very low

harmonic distortion (theoretically about 0.0015%) and high signal-to-noise ratio

(usually above 90 dB) can be recreated.

The S/PDIF-InterfaceThe main advantage of digitalizing audio signals is the fact that digital data can be

processed in many different ways by a machine (some kind of computer!) without

loss of data i.e. quality. As long as the "sound" stays digital it can be copied,

filtered apart, remixed etc. as often as you like without it sounding worse after

each generation. Most digital audio equipment is still dedicated hardware (this

situation may change in the future - remember hardware sequencers?). They are

usually equipped with digital interfaces so that audio data can be transferred

without having to convert it to analog signals first.

One interesting effect of digital transfer is that, if you copy a CD to a DAT tape,

you may find that the output of the DAT sounds better than the original CD! The

sound you hear has only been converted to analog by the DACs in the DAT

recorder, and these are often better than those in CD players (DAT recorders are

still considered "high-end" and are expensive enough to warrant using quality

components).

The Falcon does not have a digital audio interface - the S/PDIF interface has been

developed especially for this purpose. The S/PDIF is connected to the Falcon's

DSP port and expands the Falcon's arsenal of ports to include both optical and

coaxial standard digital interfaces. The combined system is thus able to copy the

digital data from a CD to hard disk, process the data and send it to DAT without

any loss of quality whatsoever. The advantage of the combination

Falcon+S/PDIF+DAT for recording analog signals is that the DAT's higher

quality ADC can be used. The S/PDIF interface also offers the standard

frequencies 44.1 kHz and 48.0 kHz which are not supported directly by the Falcon.

A Basic Principles
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DAT and CD The "professional" configuration described in the chapter "Installation and

Program Start" makes fully digital productions (DDD) possible; the digital DAT

master can be transferred directly to CD. The only necessary conversion to analog

takes place in the home of the consumer.

Unfortunately, there is one small problem: the standard sample frequencies of CD

and DAT differ. Transfer of digital audio signals is always at the rate of the

source. If, for instance, you copy a CD to DAT (digitally), the DAT recorder is

forced to record the data at 44.1 kHz although it would normally use 48.0 kHz. If

the DAT recorder is used as a DAC (for recording analog signals and converting

them to digital) it will record at 48.0 kHz. If you are planning a fully digital

production (to CD) you need recordings sampled at 44.1 kHz!

Possible solutions:

° Work with ADCs which can run at 44.1 kHz. Unfortunately, this rate is only

available in a few DAT recorders.

° The whole production is at 48.0 kHz. The sample rate is converted before the

final mix. The function "Convert Sample Rate" can run without further output in

the Edit menu.This can take several minutes because of the huge amount of data

involved.

° Use a dedicated hardware Sample Rate Converter, which either converts the

signals while recording or the final production to the CD rate in real-time. Your

AudioTracker dealer will be able to provide you with "SRC", an extra interface

which is connected to the S/PDIF. The SRC provides all the frequencies 32.0

kHz, 44.1 kHz and 48.0 kHz.

A Basic Principles
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Keyboard Commands

There are more functions available directly from the computer keyboard apart

from those listed in the menus:

Note: The symbols (,),0,* and / are on the numeric keypad.

Windows (general)Key Function

RETURN Close and keep

ESC / UNDO Close and discard

Cursor keys Scroll fine

+ SHIFT Scroll course

The tape transport padKey Function

0 or Spacebar Stop record or playback

. Stop recording and start again lying

/ Record pause

* Start recording

ENTER Start playback

( ) Wind fine (frames)

( ) + SHIFT Wind course (seconds)

( ) + CONTROL Song position to left locator/start/end

[{ Songposition to left locator

]} Songposition to right locator

I / O Punch In / Punch Out

C Cycle

S Sync

F1...F10 Restore locators

+ CONTROL Save current locators

+ SHIFT Restore song position

+ SHIFT+CONTROL Save current song position

B Keyboard Commands
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The Wave Editor The keyboard shortcuts in the Wave Editor will only work if the mouse pointer is

inside the editor window (except window handling):

Key Function

0 or Spacebar Stop audio loop

ENTER Start audio loop (playback)

* Start audio loop (record)

S Save current working area

L Load to current working area

M Set current range to maximum

; range to locators

: range to window

B Call block edit menu

- / + Horizontal zoom

shift +/- Vertical zoom

/ Tile

1...9 Restore window sets

+ CONTROL Save window sets

TAB magnify

shift TAB restore magnify

The block functions can be called directly by keyboard. You find the corresponding

key written down in the block dialog box.

Mixer 1..8 play/mute

B Keyboard Commands
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Definitionen

C.1 Song Parameters

All the parameters listed will be saved for each individual song whenever...

° the song is closed or another one opened

° The Audio Parameters window is closed with "Keep"

° the title, number of tracks or length of the song are changed via the function

"Song Structure"

° the program is terminated when a song is still open

C.2 List of Parameters

Song title, position on the hard disk, length of the song, number of tracks,

frequency of the last recording (real), all settings in the Audio Parameters

window, all mixer settings (except those of tracks being recorded) including track

names, all effect parameters including memory sets and their names, the current

and saved locator positions, the saved song positions, all synchronization settings,

all options, saved Wave Editor window sets, zero snap tolerance.

C.3 Reverb

Flow diagram of the implemented reverberation program

Version 1.1 October 1994

C Definitionen C.1 Song Parameters
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C.4 Audio Sync Format

Version 1.1 September 1994

AudioTracker has its own synchronization method based upon MIDI system

exclusive messages. Each message starts with $F0 ("sysex") according to the MIDI

standard and ends with $F7 ("eox"). The Audio format is being developed further

for future versions so that complete compatability cannot be guaranteed.

Stop $FC

Record $F0,$00,$01,$F7 - Delay - $F0,$00,$10,$F7

Play $F0,$00,$02,$F7 - Delay - $F0,$00,$10,$F7

Songpointer $F0,$00,$07,$aa,$bb,$cc,$dd,$F7

$aabbccdd (LONG) = Sampleposition in Bytes

C.4 Audio Sync Format C Definitionen
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